
第一章 ＰＬＣ概述 
一、可编程控制器的产生及定义 

①１９６９年美国数字设备公司（DEC）研制出世界第一台可编程控制 
器，并成功地应用在美国通用汽车公司（GM）的生产线上。但当时 
只能进行逻辑运算，故称为可编程逻辑控制器，简称 PLC

（programmable logic controller）。 
  ②70 年代后期，随着微电子技术和计算机技术的迅猛发展，使 PLC 从开 

关量的逻辑控制扩展到数字控制及生产过程控制域，真正成为一种电 
子计算机工业控制装置，故称为可编程控制器，简称 PC（programmable  
controller）。但由于 PC 容易与个人计算机（personal computer）相混淆， 
故人们仍习惯地用 PLC 作为可编程控制器的缩写。 

③1985 年国际电工委员会（IEC）对 PLC 的定义如下： 
可编程控制器是一种进行数字运算的电子系统，是专为在工业环境下 
的应用而设计的工业控制器，它采用了可以编程序的存储器，用来在 
其内部存储执行逻辑运算、顺序控制、定时、计数和算术运算等操作 
的指令，并通过数字或模拟式的输入和输出，控制各种类型机械的生 
产过程。 

  ④PLC 是由继电器逻辑控制系统发展而来，所以它在数学处理、顺序控 
制方面具有一定优势。继电器在控制系统中主要起两种作用：（1）逻 
辑运算（2）弱电控制强电。 

⑤PLC 是集自动控制技术、计算机技术和通讯技术于一体的一种新型工 
业控制装置，已跃居工业自动化三大支柱（PLC、ROBOT、CAD/CAM） 
的首位。 

二、可编程控制器的分类及特点 
（一）分类 

（１）从组成结构形式分 
①一体化整体式ＰＬＣ 
②模块式结构化ＰＬＣ 

（２）按Ｉ／Ｏ点数及内存容量分 
①超小型ＰＬC 
②小型ＰＬＣ 
③中型ＰＬＣ 
④大型ＰＬＣ 
⑤超大型ＰＬＣ 

   （3）按输出形式分 
     ①继电器输出 
      为有触点输出方式，适用于低频大功率直流或交流负载 
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     ②晶体管输出 
      为无触点输出方式，适用于高频小功率直流负载 

       

          
     ③晶闸管输出 
      为无触点输出方式，适用于高速大功率交流负载 
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  （二）特点 
     ①可靠性高、抗干扰能力强 
     ②编程简单、使用方便 
     ③设计、安装容易，维护工作量少 
     ④功能完善、通用性好，可实现三电一体化 
       PLC 将电控（逻辑控制）、电仪（过程控制）和电结（运 

动控制）这三电集于一体。 
     ⑤体积小、能耗低 
     ⑥性能价格比高 

三、可编程控制器的应用 
①开关量的逻辑控制 
②位置控制 
③过程控制 
④数据处理 
⑤通信联网 
⑥ＣＩＭＳ的应用 

 四、PLC 控制系统的分类 
  （一）、集中式控制系统 
   集中式控制系统是用一个 PLC 控制一台或多个被控设备。主要用于 

输入、输出点数较少，各被控设备所处的位置比较近，且相互间的 
动作有一定联系的场合。其特点是控制结构简单。 
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（二）、远程式控制系统 
   远程式控制系统是指控制单元远离控制现场，PLC 通过通信电缆与 

被控设备进行信息传递。该系统一般用于被控设备十分分散，或工 
作环境比较恶劣的场合。其特点是需要采用远程通信模块，提高了 
系统的成本和复杂性。 

 
 

  （三）分布式控制系统 
   分布式控制系统即采用几台小型 PLC 分别独立控制某些被控设备， 

然后再用通信线将几台 PLC 连接起来，并用上位机进行管理。该系 
统多用于有多台被控设备的大型控制系统，其各被控设备之间有数 
据信息传送的场合。其特点是系统灵活性强、控制范围大，但需要 
增加用于通信的硬件和软件，系统的复杂性也更大。 
 

    
 
 
 
 
 
 

 ４

www.gongkong365.com



第二章 可编程控制器原理 
 

２.1  ＰLC 的组成与基本结构 
２.1.1 ＰＬＣ的基本组成 
  ＰＬＣ主要由中央处理单元、输入接口、输出接口、通信接口等部分组 

成，其中ＣＰＵ是ＰＬＣ的核心，Ｉ／Ｏ部件是连接现场设备与ＣＰＵ 
之间的接口电路，通信接口用于与编程器和上位机连接。 
对于整体式ＰＬＣ，所有部件都装在同一机壳内；对于模块式ＰＬＣ， 
各功能部件独立封装，称为模块或模板，各模块通过总线连接，安装在 
机架或导轨上。不同厂商生产的不同系列产品在每个机架上可插放的模 
块数是不同的，一般为３－１０块。可扩展的机架数也不同，一般为２ 
－８个机架。基本机架与扩展机架之间的距离不宜太长，一般不超过 
１０M.。 

 
2.1.2 ＰＬＣ各组成部分 

1、中央处理单元ＣＰＵ 
ＣＰＵ通过输入装置读入外设的状态，由用户程序去处理，并根据

处理结果通过输出装置去控制外设。 
一般的中型可编程控制器多为双微处理器系统，一个是字处理器，

它是主处理器，由它处理字节操作指令，控制系统总线，内部计数

器，内部定时器，监视扫描时间，统一管理编程接口，同时协调位

处理器及输入输出。另一个为位处理器，也称布尔处理器，它是从
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处理器，它的主要作用是处理位操作指令和在机器操作系统的管理

下实现ＰＬＣ编程语言向机器语言转换。 
ＣＰＵ处理速度是指ＰＬＣ执行１０００条基本指令所花费的时

间。 
2、存储器 

存储器主要存放系统程序，用户程序及工作数据。 
ＰＬＣ所用的存储器基本上由ＰＲＯＭ，ＥＰＲＯＭ，ＥＥＰＲＯ

Ｍ及ＲAM 等组成。 
3、输入／输出部件 

输入／输出部件又称Ｉ／Ｏ模块。ＰＬＣ通过Ｉ／Ｏ接口可以检测

被控对象或被控生产过程的各种参数，以这些现场数据作为ＰＬＣ

对控对象进行控制的信息依据。同时ＰＬＣ又通过Ｉ／Ｏ接口将处

理结果送给被控设备或工业生产过程，以实现控制。 
4、编程装置和编程软件 

ＰＬＣ是以顺序执行存储器中的程序来完成其控制功能的。 
5、电源部件 
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2.2   ＰＬＣ的基本工作原理 
２.2.1  ＰＬＣ的循环扫描工作过程 
  （一）ＰＬＣ的循环扫描 
  ＰＬＣ的ＣＰＵ是采用分时操作的原理，每一时刻执行一个操作，随着 

时间的延伸一个动作接一个动作顺序地进行，这种分时操作进程称为 
ＣＰＵ对程序的扫描。ＰＬＣ的用户程序由若干条指令组成，指令在存 
储器中按序号顺序排列。ＣＰＵ从第一条指令开始，顺序逐条地执行用 
户程序，直到用户程序结束，然后返回第一条指令开始新的一轮扫描。 
（二）ＰＬＣ工作过程 
1、公共操作 

公共操作是在每次扫描程序前进行的自检。 
2、数据Ｉ／Ｏ操作 

数据Ｉ／Ｏ操作也称为Ｉ／Ｏ状态刷新。它包括两种操作： 
①采样输入信号，即刷新输入状态表的内容 
②送出处理结果，即用输出状态表的内容刷新输出电路 

3、执行用户程序操作 
4、处理外设请求操作 

外设的请求命令包括操作人员的介入和硬件设备的中断 
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２.2.2 ＰＬＣ的Ｉ／Ｏ滞后现象 
  造成Ｉ／Ｏ响应滞后的原因： 
  ①扫描方式 
  ②电路惯性 
    输入滤波时间常数和输出继电器触点的机械滞后 
  ③与程序设计安排有关 
 

 
２.３  ＰＬＣ的编程语言 

２.3.1  梯形图编程 

（一）PLC 的编程特点 
  1、程序的执行顺序 

 ８

www.gongkong365.com



    

  两图实现相同的功能。当 IS1 闭合时，1Y1、1Y2 输出。系统上 
电之后，当 1S1 闭合时，继电器梯形图中的 1Y1、1Y2 会同时得

电，若不考虑继电器触点的延时，则 1Y1、1Y2 会同时输出。但

在 PLC 梯形图中，因为 PLC 的程序是顺序扫描执行的，PLC 的

指令按从上向下，从左向右的扫描顺序执行，整个 PLC 的程序

不断循环往复。PLC 的“继电器”的动作顺序由 PLC 的扫描顺

序和在梯形图中的位置决定，因此，当 1S1 闭合时，1Y1 先输出

而 1Y2 后输出。即继电器采用并行的执行方式，而 PLC 则采用

串行的执行方式。 

 

2、继电器自身的延时效应 
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  传统的继电器的触点在线圈得电后动作时有一个微小的延时， 
并且常开和常闭触点的动作之间有一微小的时间差。而 PLC 
中的继电器都为软继电器，不会有延时效应，当然，这里忽略 
了 PLC 的扫描时间。 

3、PLC 中的软继电器 
 每个继电器有无数个常开和常闭触点。 

（二）PLC 编程的基本原则 
（１）每个梯形图网络由多个梯级组成，每个输出元素可构成一 

个梯级，每个梯级可由多个支路组成。 
（２）梯形图每一行都是从左母线开始，而且输出线圈接在最右 

边，输入触点不能放在输出线圈的右边。 
（３）输出线圈不能直接与左母线连接。 
（４）多个的输出线圈可以并联输出。 
（５）在一个程序中各输出处同一编号的输出线圈若使用两次

称为“双线圈输出”。双线圈输出容易引起误动作，禁止

使用。 
（６）ＰＬＣ梯形图中，外部输入／输出继电器、内部继电器、

定时器、计数器等器件的触点可多次重复使用。 
（７）梯形图中串联或并联的触点的个数没有限制，可无限次的

使用。 
（８）在用梯形图编程时，只有在一个梯级编制完整后才能继续

后面的程序编制。 
（９）梯形图程序运行时其执行顺序是按从左到右，从上到下的

原则。 
（二）编程技巧及原则“上重下轻，左重右轻，避免混联” 

（１）梯形图应把串联触点较多的电路放在梯形图上方 
（２）梯形图应把并联触点较多的电路放在梯形图最左边 
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（３）为了输入程序方便操作，可以把一些梯形图的形式作适当

变换 

 
2.3.2  语句表编程 
  ＰＬＣ的语句：操作码＋操作数 
    操作码用来指定要执行的功能，告诉ＣＰＵ该进行什么操作；操 

作数内包含为执行该操作所必需的信息，告诉ＣＰＵ用什么地方 
的数据来执行此操作。 
操作数的分配原则： 

（１）为了让ＣＰＵ区别不同的编程元素，每个 
独立的元素应指定一个互不重复的地址 

（２）所指定的地址必须在该型机器允许的范

围之内。 
2.3.3  其它编程语言 
  功能图编程．高级编程语言（Ｃ语言．Pascal 语言等） 

编程语言 用户类 应用 
语 句 表

（STL） 
愿意用类似于机器码语

言编程的用户 
程序在运行时间和存贮

空间要求上最优 

梯 形 图

（LAD） 
习惯电路图的用户 
 

编写逻辑控制程序 
 

功 能 图

（FBD） 
熟悉布尔代数逻辑图的

用户 
编写逻辑控制程序 
 

SCL（结构控

制语言）可选

软件包 

用高级语言。如 PASCAL
或 C 语言编程的用户 
 

数据处理任务程序 
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S7 Graph（顺

序控制）可选

软件包 

有技术背景，没有 PLC 编

程经验的用户 
以顺序过程的描述很方

便 

S7 HiGraph
（状态图形）

可选软件包 

有技术背景，没有 PLC 编

程经验的用户 
以异步非顺序过程的描

述很方便 

CFC（连续功

能图）可选软

件包 

有技术背景，没有 PLC 编

程经验的用户 
适用于连续过程的描述 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

第三章 SIMATIC S7-300 PLC 系统特性及硬件构成 
3.1 S7-300 PLC 系统结构 

3.1.1 S7-300 PLC 的组成 
 主要组成部分有导轨（ＲＡＣＫ）、电源模块（ＰＳ）、中央处理单元ＣＰＵ 

模块、接口模块（ＩＭ）、信号模块（ＳＭ）、功能模块（ＦＭ）等，通过 
ＭＰＩ网的接口直接与编程器ＰＧ、操作员面板ＯＰ和其它Ｓ７ＰＬＣ相 
连。 

3.1.2 S7-300 的扩展能力 
 CPU314 一个机架上最多只能再安装八个信号模块或功能模块，最多可以扩 

展为四个机架。中央处理单元总是在０机架的２号槽位上，１号槽安装电 
源模块，３号槽总是安装接口模块，槽号４至１１，可自由分配信号模块、 
功能块。 

3.1.3 S7-300 模块地址的确定 
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 数字Ｉ／Ｏ模块每个槽划分为４Ｂyte（等于３２个Ｉ／Ｏ点），模拟Ｉ／Ｏ 

模块每个槽划分为１６Byte（等于８个模拟量通道），每个模拟量输入或输 

出通道的地址总是一个字地址。 
槽号 

机架 
模 板

起 始

地址 
1 2 3 4 5 6 7 8 9 10 11 

0 

数字

量 
模 拟

量 

PS CPU IM

0 
256

4 
272

8 
288

12 
304

16 
320

20 
336 

24 
352 

28 
368

1 

数字

量 
模 拟

量 

 
 

IM

32 
384

36 
400

40 
416

44 
432

48 
448

52 
464 

56 
480 

60 
496

2 

数字

量 
模 拟

量 

 
 

IM

64 
512

68 
528

72 
544

76 
560

80 
576

84 
592 

88 
608 

92 
624

3 

数字

量 
模 拟

量 

 
 

IM

96 
640

100
656

104
672

108
688

112
704

116 
720 

120 
736 

124
752

 
 怎样确定信号模板的地址 

（一）确定数字量模板的地址 
一个数字量模板的输入或输出地址由字节地址和位地址组成。字节地

址取决于其模板起始地址。 
例如：如果一块数字量模板插在第 4 槽里，其地址分配如下： 
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（二）确定模拟量模板的地址 

模拟量输入或输出通道的地址总是一个字地址。通道地址取决于模板

的起始地址。 
例如：如果第一块模拟量模板插在第 4 号槽，其地址分配如下： 
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3.2 S7-300 PLC 存储区简介 

3.2.1 S7-300 编程方式简介 

  S7-300 PLC 的编程软件是 STEP 7。 

  用户程序由组织块(OB)、功能块(FB,FC)、数据块(DB)构成。 

OB 是系统操作程序与用户应用程序在各种条件下的接口界面，用于控制 

程序的运行。OB1 是主程序循环块，在任何情况下，它都是需要的。 

功能块(FB,FC)实际上是用户子程序，分为带“记忆”的功能块 FB 和不 

带“记忆”的功能块 FC。前者有一个数据结构与该功能块的参数表完全 

相同的数据块(DB)附属于该功能块,并随着功能块的调用而打开，随着功 

能块的结束而关闭。该附属数据块(DB)叫做背景数据块，存在背景数据 

块中的数据在 FB 块结束时继续保持，也即被“记忆”。功能块 FC 没有背 

景数据块，当 FC 完成操作后数据不能保持。 

数据块(DB)是用户定义的用于存放数据的存储区。 

S7 CPU 还提供标准系统功能块(SFB,SFC)。 

 

3.2.2 S7-300 PLC 的存储区 

  S7-300 CPU 有三个基本存储区： 

（１）系统存储区：ＲＡＭ类型，用于存放操作数据（Ｉ／Ｏ、

位存储、定时器、计数器等）。 

（２）装载存储区：物理上是ＣＰＵ模块中的部分ＲＡＭ，加上

内置的ＥＥＰＲＯＭ或选用的可拆卸ＦＥＰＲＯＭ卡，用 

于存放用户程序。 

（３）工作存储区：物理上是占用ＣＰＵ模块中的部分ＲＡＭ，

其存储内容是ＣＰＵ运行时，所执行的用户程序单元（逻

辑块和功能块）的复制件。 

    ＣＰＵ程序所能访问的存储区为系统存储区的全部、工作存储区 

中的数据块ＤＢ、暂时局部数据存储区、外设Ｉ／Ｏ存储区等。 
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       程序可访问的存储区及功能   

名称 存储区 存储区功能 

 

 

输入(I) 

 

 

输入过程映象

表 

扫描周期开始，操作系统读取过

程输入值并录入表中，在处理过

程中，程序使用这些值 

每个 CPU 周期，输入存储区在输

入映象表中所存放的输入状态

值，它们是外设输入存储区头

128Byte 的映象 

 

 

输出(Q) 

 

 

输出过程映象

表 

在扫描周期中，程序计算输出值

并存放该表中，在扫描周期结束

后，操作系统从表中读取输出

值，并传送到过程输出口，过程

输出映象表是外设输出存储区

的头 128Byte 的映象 

位存储区

(M) 

存储位 存放程序运算的中间结果 

外设输入

(PI) 

外设输出

(PQ) 

I/O:外设输入

I/O:外设输出

外设存储区允许直接访问现场

设备（物理的或外部的输入和输

出），外设存储区可以字节，字

和双字格式访问，但不可以位方

式访问 

 

 

定时器(T) 

 

 

定时器 

为定时器提供存储区 

计时时钟访问该存储区中的计

时单元，并以减法更新计时值 

定时器指令可以访问该存储区

和计时单元 

计数器(C) 计数器 为计数器提供存储区，计数指令

访问该存储区 

 

 

临 时 本 地

数据(L) 

 

 

本地数据堆栈

（Ｌ堆栈） 

在ＦＢ、ＦＣ可ＯＢ运行时设

定。在块变量声明表中声明的暂

时变量存在该存储区中，提供空

间以传送某些类型参数和存放

梯形图中间结果。块结束执行

时，临时本地存储区再行分配。

 １６

www.gongkong365.com



不同的CPU提供不同数量的临时

本地存储区 

 

数据块

(DB) 

 

据块 

ＤＢ块存放程序数据信息，可被

所有逻辑块公用（“共享”数据

块）或（被ＦＢ特定占用“背景”

数据块） 

 

3.3 S7-300 PLC 中央处理单元 CPU 模块 

3.3.1 CPU 模块概述 

  中央处理单元ＣＰＵ的主要特性，包括存储器容量、指令执行时间、最 

大Ｉ／Ｏ点数、各类编程元件（位存储器、计数器、定时器、可调用块） 

数量等。 

  S7-300 可编程控制器 CPU314 的技术数据 

程序存储量 24K 

每 1K 语句执行时间 0.3ms 

计数器 
64 个（C0~C63） 
计数范围：0~999 

定时器 
128 个（T0~T127） 
定时范围：10ms~9990s 

通讯接口 MPI 

编程软件 STEP7 

位存储器 2048 个（MB0~MB255） 

数据块 
最多 127（DB0 保留） 
大小：最大 8KB 
嵌套深度：8 层 

机架 
最多 4 个 
每个机架的信号模块数：最多 8
个 

应用场合 
对编程范围和操作处理速度有

高要求的大型设备 
    
3.3.2  CPU 模块的方式选择开关和状态指示二极管 
  S7-300 的 CPU 有四种工作方式，通过可卸的专用钥匙控制： 
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（１）ＲＵＮ－Ｐ：可编程运行方式。 

（２）ＲＵＮ：运行方式。 

（３）ＳＴＯＰ：停机方式。 

（４）ＭＲＥＳ：ＣＰＵ清零 

用钥匙开关进行程序的清除 
在开始一个新的编程工作时，我们需要将中央处理器进行清零处理。它 
将很容易地通过操作 CPU 上的钥匙开关来实现。为此我们必须进行以下 
的操作步骤： 

1．接通 PLC 工作电源，并等待至 CPU 的自检测运行完成 
2．转动钥匙开关至 MRES 位置，并保持这个状态，直至 STOP 发光 

二极管从闪动转为常亮状态 
   3．钥匙开关转至 STOP 位置并迅速转回 MRES 位置，保持这个状态， 
     STOP 发光二极管开始快速闪动 
   4．STOP 发光二极管的快速闪动，表示 CPU 已被清零 
   5．松开钥匙开关，这时钥匙会自动返回 STOP 位置 
   6．可编程控制器已被清零，并可以传输新的控制程序 

程序的下传只能是钥匙开关在 STOP 或 RUN－P 位置进行 
3.3.3 CPU 单元的参数设置 

（１）时钟存储器 

S7-300 有８个时钟存储器，每个频率都不一样。可以在０－ 

２５５范围内定义任一字节为时钟存储器字节。 

 

A period duration/frequency is assigned to each bit of the 

clock memory byte: 

 

Bit 7 6 5 4 3 2 1 0 

Period 

duration (s): 2 1.6 1 0.8 0.5 0.4 0.2 0.1 

Frequency 

(Hz): 0.5 0.625 1 1.25 2 2.5 5 10 
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（２）循环中断参数 

 
（３）最长循环时间 
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（４）ＭＰＩ参数 

 

 

3.3.4 CPU 的循环时间计算 

  循环时间是一个程序循环所占用的时间，循环时间由过程映像传送时 

间、操作系统的执行时间和用户程序的执行时间三大部分组成 

 

练习： 

一、填空题： 

（1）美国数字设备公司于（   ）年研制出世界第一台ＰＬＣ。 

（2）ＰＬＣ从组成结构形式上可以分为（      ）和（ 

      ）两类。 

（3）ＰＬＣ以（    ）工作方式工作的。 

（4）一般由程序控制的数字电子设备产生的故障常有两种，一种是（ 

   ）；另一种是（    ）。 

（5）ＰＬＣ是由（   ）逻辑控制系统发展而来的，它在（ 

    ）、（    ）方面具有一定优势。 

（6）ＰＬＣ的基本组成主要由（    ）、（   

       ）、（     ）、（    ）等部分组成。 

（7）ＰＬＣ的处理速度是指ＰＬＣ执行（    ）条基本指令所 

花费的时间。 

  （8）ＰＬＣ所用的存储器基本上由（    ）、（  

  ）、（   ）等组成。 

  （9）ＰＬＣ运行时，内部要进行一系列操作，大致可分为四大类：（ 
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     ）操作、（   ）操作、（    ）操作、（ 

     ）操作。 

  （10）常用的ＰＬＣ编程语言有（     ）、（   

     ）、（    ）等。 

  （11）S7-300 PLC 314CPU 一个机架最多可安装（  ）个信号模 

块，最多可扩展为（  ）个机架，机架之间的通讯距离最 

大不超过（   ），最大数字量Ｉ／Ｏ点数（   ），

支持的可保持的定时器最多为（   ）个，计数器最多 

为（  ）个。 

  （12）CPU314 支持的 OB、FB、FC、DB 的容量均不大于（  ）KB。 

  （13）确定机架０的６号槽上 SM323  DI8/DO8 的地址范围（  

          ）以及５号槽上 SM334  AI4/AO2 的地址 

范围（       ）。 

  （14）手编器一般采用（   ）语言编辑。 

  （15）高速、大功率的交流负载，应选用（   ）输出的输出接口 

电路。 

  （16）PLC 产品手册中给出的“存储器类型”和“程序容量”是针对 

（    ）存储器而言。 

  (17)PLC 控制系统分（    ）、（    ）、（  

     ）三大类。 

  （18）S7-300 CPU 所用的存储区基本上由（    ）、（  

  ）、（   ）组成。 

  （19）ＣＰＵ程序所能访问的存储区为（     ）、（ 

      ）、暂时局部数据存储区、外设Ｉ／Ｏ存储区等 

二、画出下面程序正确的梯形图 
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三、判断题 

 1、输入继电器只能由外部信号驱动，而不能由内部指令来驱动。 

（  ） 

 2、输出继电器可以由外部输入信号或 PLC 内部控制指令来驱动。 

                （  ） 

 3、内部继电器既可以供内部编程使用，又可供外部输出。 （  ） 

 4、PLC 内部的“软继电器”（即由 PLC 内部的存储单元构成的，包括定时器、 

计数器等）均可提供无数副常开、常闭触点供编程使用。（  ） 

 5、PLC 的 I/O 地址编号可以随意设定。      （  ） 

 

 

 

 

 

 答案：1、√ 2、X 3、X 4、√ 5、X 
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第四章  编程语言 

操作系统：操作系统由 PLC 的生产厂提供，它支持用户程序 

PLC 的程序     的运行 

     用户程序：用户程序是用户为完成特定的控制任务而编写的 

应用程序 

 

        梯形图编程（LAD） 

PLC 常用的编程语言  语句表编程（STL） 

        功能图编程（FBD） 

       

  注：对于数字量模块不一定要进行硬件组态，而对于模拟量模块一定要 

进行硬件组态。 

4.1 指令及其结构 

指令是程序的最小独立单位,用户程序是由若干条顺序排列的指令构成. 

4.1.1 指令的组成 

 1.语句指令 

   语句指令用助记符表示 PLC 要完成的操作。 
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   指令:操作码＋操作数  
   操作码用来指定要执行的功能，告诉ＣＰＵ该进行什么操作；操作 

数内包含为执行该操作所必需的信息，告诉ＣＰＵ用什么地方的数 
据来执行此操作。 

   例如: 操作码  操作数 

      0      I0.0 

      O   I0.1 

      =      Q0.0 

   有些语句指令不带操作数,因为它们的操作对象是唯一的。 

   例如：操作码  操作数 

     NOT 

     SET 

 2.梯形图指令 

   梯形图指令用图形元素表示 PLC 要完成的操作。在梯形图指令中，其操作 

码是用图素表示的，该图素形象表明 CPU 做什么，其操作数的表示方法与 

语句指令相同。 

例如： 

    

梯形图指令也可不带操作数。 

例如： 

   

4.1.2 操作数 

1.标识符及标识参数 

       主标识符(操作数存放的存储器的区域):  I 

    标识符      Q、PI、PQ、M、T、C、L、DB 

 操作数     辅助标识符（操作数的位数长度）：X、B、W、D 

    标识参数（操作数在该存储区域内的具体位置） 

    注释：I：输入过程映像存储区 

Q：输出过程映像存储区 

       PI：外部输入 

       PQ：外部输出 
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        M：位存储区 

        T：定时器 

        C：计数器 

      L：本地数据 

       DB：数据块 

      X：位 

      B：字节 

      W：字 

      D：双字 

注意：①PLC 物理存储器是以字节为单位的。 

   ②当操作数长度是字或双字时，标识符后给出的标识参数是字或双 

字内的最低字节单元号。 

   ③当使用宽度是字或双字的地址时，应保证没有生成任何重叠的字 

节分配，以免造成数据读写错误。 

2.操作数的表示法 

       物理地址(绝对地址) 

 操作数的表示法  

       符号地址(必须先定义后使用，而且符号名必须是 

唯一的) 

  关于定义符号地址的几点说明： 

  （一）当你在表中输入符号地址时，应注意以下几点： 

   

列 注意 

符号 

 

在整个符号表中名字必须唯一。当你确认该区域的输入

或退出该区域时，不唯一的符号则被标定出来。符号名

最长可达 24 个字符。引号（“”）不允许使用。 

地址 当你确认该区域的输入或退出该区域时，程序会自动检

查该地址输入是否是允许的。 

数据类型 当你确认或退出地址时，该区域被自动地赋予一个缺省

数据类型。如果你修改这个缺省类型，程序会检查你的

数据类型是否与地址相匹配。 

注释 你可以输入注释简单地解释该符号的功能（最多 80 个字

符）。 

 

  （二）你必须区分局域（块定义）符号和共享符号 

 

 ２５

www.gongkong365.com



 共享符号 局域符号 

有效性 

 

 

 

•在整个用户程序中有效 

•可以被所有的块使用 

•在所有的块中含义是一样的

•在整个用户程序中是唯一的

•只在定义的块有效 

•相同的符号可在不同

的块中用于不同的目

的 

允 许 使 用

的字符 

 

 

•字母、数字及特殊字符。 

•除 0X00，0XFF 及引号以外的强

调号 

•如使用特殊字符，则符号须写

出在引号内。 

•字母 

•数字 

•下划线（_）（注意：

不允许使用两个连续

的下划线） 

使用 

 

 

 

 

 

 

 

你可以为以下各项定义共享符

号： 

•I/O 信号（I，IB，IW，ID，Q，

QB，QW，QD） 

•I/O 输入与输出（PI，PQ） 

•存储位（M，MB，MW，MD） 

•定时器（T）/计数器（C） 

•逻辑块（FB，FC，SFB，SFC）

•数据块（DB） 

•用户定义数据类型（UDT） 

•变量表（VAT） 

你可以为以下各项定

义局域符号： 

•块参数（输入，输出

和输入输出参数） 

•块的静态数据 

•块的临时数据 

 

 

 

 

 

在 哪 里 定

义 

符号表 块的变量声明表 

   

  （三）显示共享或局域符号 

  你可以在程序的指令部分区分开共享符号和局域符号。 

  •符号表中定义的符号（共享）显示在引号内。 

  •块变量声明表中的符号（局域）显示时前面加上“#”。 

  提示： 

  使用菜单命令 View>Display>Symbolic Representation，你可以在所有 

声明的符号地址和绝对地址之间进行切换。 
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4.1.3 寻址方式 

 寻址方式是指令得到操作数的方式。 

     立即寻址：操作数本身直角接包含在指令中 

     直接寻址：指令中直接给出操作数的存储单元地址 

S7 寻址方式  存储器间接寻址 

     寄存器间接寻址 

         

 

 

 

 

常数 

        S7 状态字中的状态位 

        S7 的各种寄存器 

  S7 指令的操作对象  数据块 

        功能块 FB、FC 和系统功能块 SFB、SFC 

        S7 的各存储区中的单元 

 

4.1.4 数据类型 

 数据类型决定了你以什么方式或格式理解或访问存储区中的数据。 

     基本数据类型：定义不超过 32 位的数据 

     复式数据类型：定义超过 32 位或由其它数据类型组成 

数据类型        的数据 

     参数类型：定义传给 FB 块和 FC 块的参数 

4.1.5 状态字 

 状态字用于表示 CPU 执行指令时所具有的状态。 

  

如何输入梯形图组件： 
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  1、在段中选择一点，你想在该点后面插入一个梯形图组件。 

  2、用下列方法之一，在段中插入所需的组件： 

   • 在菜单“Insert”中选择合适的菜单命令，例如， 

    Insert>LAD Element>Normally Open Contact 

   • 用功能键 F2、F3 或 F7 输入一个常开触点、常闭触点或输出线圈。 

   • 选择菜单命令 Insert>Program Elements 打开“program Elements 

（编程组件）”对话框并在目录中选择所需的组件。 

   所选的梯形图组件被插入，问号被用来表示地址和参数。 

 如何输入语句表语句： 

  1、通过点击灰色注释框下面的任意区域就可打开正文框（或者若不显示 

段注释则在段标题的下面）。 

  2、输入指令、按空格键，然后是地址（直接或间接地址）。 

  3、按空格键并输入以双斜线//开始的注释（可选）。 

  4、在完成一条（一行）带注释或不带注释的语句后按 RETURN。 

  一行完成后，运行语法检查，这条语句形成并显示，指令中或绝对地址 

中的任何小写字母都转换为大写。任何查到的语法错误都显示为红色斜 

体，在存储该逻辑块之前必须修改所有错误。 
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4.2 位逻辑指令 

 

     位逻辑运算指令 

位逻辑指令    定时器指令 

     计数器指令 

     位测试指令 

4.2.1 位逻辑运算指令 

1.“与”、“或”、“异或”指令 

 （1）语句指令     

   布尔逻辑串内的真值表（根据下列表可以确定第二条布尔位操作 

后的 RLO） 

助记符 指令 指令前 RLO 地址状态 RLO 结果 

A 

 

 

 

与 

 

 

 

0 

0 

1 

1 

0 

1 

0 

1 

0 

0 

0 

1 

AN 

 

 

 

与非 

 

 

 

0 

0 

1 

1 

0 

1 

0 

1 

0 

0 

1 

0 

O 

 

 

 

或 

 

 

 

0 

0 

1 

1 

0 

1 

0 

1 

0 

1 

1 

1 
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ON 

 

 

 

或非 

 

 

 

0 

0 

1 

1 

0 

1 

0 

1 

1 

0 

1 

1 

X 

 

 

 

异或 

 

 

 

0 

0 

1 

1 

0 

1 

0 

1 

0 

1 

1 

0 

XN 

 

 

 

异或非 

 

 

 

0 

0 

1 

1 

0 

1 

0 

1 

1 

0 

0 

1 

     布尔逻辑串开始的真值表      

助记符 指令 地址状态 RLO 结果 

A 

 

与 

 

0 

1 

0 

1 

AN 

 

与非 

 

0 

1 

1 

0 

O 

 

或 

 

0 

1 

0 

1 

ON 

 

或非 

 

0 

1 

1 

0 

X 

 

异或 

 

0 

1 

0 

1 

XN 

 

异或非 

 

0 

1 

1 

0 

  （2）梯形图逻辑指令 

     ①常开接点（动合触点）元素和参数 

      

     ②常闭接点（动断触点）元素和参数 

      
2.输出指令 
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   输出指令把状态字中 RLO 的值赋给指定的操作数 

STL 指令 LAD 指令 功能 操作数 数据类

型 

存储区 

=<地址> 

 

  <地址> 

---(  ) 

逻辑串赋

值输出 

<位地址> BOOL 

 

I,Q,M, 

D,L 

 

 

 <地址> 

--(#)-- 

中间结果

赋值输出

<位地址> 

 

BOOL 

 

I,Q,M, 

D,L 

    

例一 二分频器 

   二分频器是一种具有一个输入端和一个输出端的功能单元,输出频率为输 

入频率的一半。如下，输入为 I0.0,输出为 Q4.0。 

 

   
 

 

 

  梯形图程序： 

   

  语句表程序： 
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例二  风机监控程序 

  某设备有三台风机，当设备处于运行状态时，如果风机至少有两台以上 

转动，则指示灯常亮；如果仅有一台风机转动，则指示灯以 0.5Hz 的频 

率闪烁；如果没有任何风机转动，则指示灯以 2Hz 的频率闪烁。当设备 

不运行时，指示灯不亮。 

梯形图程序： 

 

语句表程序： 
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  输入位 I0.0,I0.1,I0.2 分别表示风机 1,2,3。存储位 M100.3 为 2Hz 的 

频率信号,M100.7 为 0.5Hz 的信号。风机转动状态指示灯由 Q4.0 控制。 

存储位 10.0 为 1 时用于表示至少有两台风机转动,M10.1 为 1 时表示没 

有风机转动。 

例三  启动和自锁程序 

  程序功能：输入 X0 闭合时，输出 Y0 闭合且自锁。只有在 X1 闭合时，其 

动断触点打开，Y0 断开。其时序图如下。 
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梯形图程序： 

   

  语句表程序： 

   

  练习：请指出以下实现输出 Q0.0、Q0.1 互锁程序的错误，并改正。 

   

例四  优先程序 

  优先程序执行时，能在多个输入信号中仅接收最先一个输入信号作出反 

映，其后的输入信号不接收。此原则常用于抢答器中。 
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例五  灯泡控制程序 

  一盏灯泡由一个按钮来控制，已知第一次按下按钮，灯泡亮，第二次按 

下按钮，灯光灭。 

 

 

（一）PLC 接线图 

 
（二）定义符号地址   

符号地址 绝对地址 类据类型 说明 

S0 I0.0 BOOL 按钮 

L0 Q0.0 BOOL 灯泡 

M0 M0.0 BOOL 标标位 

（三）梯形图程序
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例六  双作用气缸连续往复运动控制 

  按启动按钮双作用气缸连续往复运动，按停止按钮，停止运动。 

  （一）气控回路 

 

     

  （二）PLC 接线 

    
（三）定义符号地址   
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符号地址 绝对地址 类据类型 说明 

S0 I0.0 BOOL 启动按钮 

S1 I0.1 BOOL 停止按钮 

1S1 I0.2 BOOL 位置传感器 

1S2 I0.3 BOOL 位置传感器 

1Y1 Q0.0 BOOL 换向阀电磁线

圈 

1Y2 Q0.1 BOOL 换向阀电磁线

圈 

M0 M0.0 BOOL 启动线圈 

（四）梯形图程序 

   

   

  

 练习：编制电动机点动和连续运转控制程序。 

   

输入端 控制触点 控制功能 输出端 执行器件 实现功能 

I0.0 

 

停止按钮 

(常开) 

停止 

 

Q0.0 

 

KM1 

 

控制电动

机电源 

I0.1 

 

点动按钮 

(常开) 

点动 

 

Q0.1 

 

保护指示

灯 

当保护动

作时闪亮 

I0.2 

 

连续运转

按钮(常

开) 

连续运转启动
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I0.3 

 

热继电器

触点(常

闭) 

过载保护动作

使得电机停止

 

 

 

 

 

 

 

参考程序： 

（一）定义符号地址 

 

 
（二）LAD 程序 

 

练习：编制双控灯控制程序，要求开关 K1 或 K2 任意一个开关的开和 

关的操作均可以控制灯 L的亮和灭。完成后可再编制三控灯。 

参考程序 

程序 1： 
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3.置位／复位指令 

    

STL 指令 LAD 指令 功能 操作数 数据类型 存储区 

S<位地址> 

 

  <位地址> 

---(S) 

置位输出 <位地址> BOOL 

 

I,Q,M, 

D,L 

R<位地址＞ 

 

 <位地址> 

--(R) 

复位输出 <位地址>

 

BOOL,TIMER，

COUNTER 

I,Q,M,D 

,L,T,C 

 复位/置位指令根据 RLO 的值，来决定被寻址位的信号状态是否需要改变。 

若 RLO 的值为 1,被寻地址位的信号状态被置 1或清 0；若 RLO 的值为 0,被寻 

址位的信号保持原状态不变。这一特性又称为静态的置位／复位。相应地，

赋值输出被称为动态赋值输出。在 LAD 中置位／复位指令要放在逻辑串最右

端，而不能放在逻辑串中间。 

 

4. RS 触发器 

  

  

置位复位触发器真值表 

S R Q 

0 0 － 

0 1 0 
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1 0 1 

1 1 0 

 复位置位触发器真值表 

R S  Q 

0 0 － 

0 1 1 

1 0 0 

1 1 1 

 在 LAD 中，RS 触发器可以用在逻辑串最右端，结束一个逻辑串，也可用在

逻 

 辑串中，影响右边的逻辑操作结果。 

例一  控制传送带 

 一个由电气启动的传送带，在传送带的起点有两个按钮开关：用于 START 的 

S1 和 STOP 的 S2。在传送带的尾部也有两个按钮开关：用于 START 的 S3 和 

STOP 的 S4。可以从任何一端起动或停止传送带。另外，当传送带上的物件 

到达末端时，传感器 S5 使传送带停机。 

 （一）PLC 接线 

  
 

 

 

（二）定义符号地址 

符号地址 绝对地址 类据类型 说明 
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S1 I0.0 BOOL 起点启动按钮 

S2 I0.1 BOOL 起点停机按钮 

S3 I0.2 BOOL 尾部启动按钮 

S4 I0.3 BOOL 尾部停机按钮 

S5 I0.4 BOOL 末端传感器 

MOTOR_ON Q0.0 BOOL 电机 

（三）梯形图程序    

 

 

思考题: 

 如下的程序有什么不足之处？应如何改正？ 

  

 

例二 双缸顺序动作控制程序 

 设计程序,使两个气缸顺序动作,其顺序为:A1B1B0A0。 

 

 （一）气控回路 
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 (二)位移-步骤图 

  1  2     3    4    5=1 

   

  1 

 A 

    0 

 1 

 B 

    0 

 

 （三）I型障碍信号分析 

   

 （四）PLC 接线 

 ４２

www.gongkong365.com



   
 （五）定义符号地址 

    

 （六）梯形图程序 
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5.RLO 上升沿、下降沿检测指令  

LAD 指令 STL 指令 功能 操作数 数据类型 存储区 

<位地址> 

-(P)- 

FP<位地址> RLO 上升

沿检测 

BOOL I、Q、M、

D、L 

<位地址> 

-(N)- 

FN<位地址> RLO 下降

沿检测 

<位地址>

存储旧

RLO 的边

沿存储位

BOOL I、Q、M、

D、L 
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RLO 上升沿检测指令识别 RLO 从 0 至 1（上升沿）的信号变化，并且在操 

 作之后以 RLO＝1 表示这一变化。用边沿存储位比较 RLO 的现在的信号状态 

与该地址上周期的信号状态，如果操作之前地址的信号状态是 0，并且现在 

RLO＝1，那么操作之后，RLO 将为 1（脉冲），所有其它的情况为 0。在该操 

作之前，RLO 存储于地址中。 

RLO 下降沿检测指令识别 RLO 从 1 至 0（下降沿）的信号变化，并且在操 

 作之后以 RLO＝1 表示这一变化。用边沿存储位比较 RLO 的现在的信号状态 

与该地址上周期的信号状态，如果操作之前地址的信号状态是 1，并且现在 

RLO＝0，那么操作之后，RLO 将为 1（脉冲），所有其它的情况为 0。在该操 

作之前，RLO 存储于地址中。 

 如果 RLO 在相邻的两个扫描周期中相同（全为 1 或 0），那么 FP 或 FN 语 

句把 RLO 位清 0。 

6.地址上升沿、下降沿检测指令 

  

  

  地址上升沿检测指令将<位地址 1>的信号状态与存储在<位地址 2>中的 

先前信号状态检查时的信号状态比较。如果有从 0至 1的变化的话，输出 Q 

为 1，否则为 0。 

  地址下降沿检测指令将<位地址 1>的信号状态与存储在<位地址 2>中的 

先前信号状态检查时的信号状态比较。如果有从 1至 0的变化的话，输出 Q 

为 1，否则为 0。 

 在梯形图中，地址跳变沿检测方块和 RS 触发器方块可被看作一个特殊常 

开触点。该常开触点的特性：若方块的 Q为 1，触点闭合；若 Q为 0，则触 

点断开。 

7.对 RLO 的直接操作指令 
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LAD 指令 STL 指令 功能 说明 

-|NOT|- NOT 取反 RLO 在逻辑串中,对当前的 RLO 取反;

取反指令或置位 STA 

------- SET 置位 RLO 把 RLO 无条件置 1 并结束逻辑串;

使 STA 置 1,OR FC 清 0 

------- CLR 复位 RLO 把 RLO 无条件清 0 并结束逻辑串;

清 0 STA,OR FC 

-(SAVE) SAVE 保存 RLO 把 RLO存入状态字的BR位,该指令

不影响其它状态位 

 

例一 检测传送带的方向 

 

 装备有两个光电传感器(PEB1 和 PEB2)的传送带，该设计能够检测传送带上 

物件的运动方向，并通过左右两端的指示灯（LEFT 灯和 RIGHT 灯）显示。 

  
 

 （一）PLC 接线 
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  （二）定义符号地址 

      

  （三）梯形图程序 

    

 

例二  二分频器 

 

二分频器是一种具有一个输入端和一个输出端的功能单元,输出频率为输 

入频率的一半。如下，输入为 I0.0,输出为 Q4.0。 

 

         
 

  分析二分频的时序图看到，输入每有一个正跳沿，输出便反转一次。据 

此，可用跳变沿检测指令实现分频功能。 

  梯形图程序 1： 
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 梯形图程序 2： 

 

 

例三  传送带定位控制 

  一电动机带动一个传送带运动，要求移动传送带向前或向后到达某一确 

定的位置，其结构示意图如下，为了正确定位该传送带，有时需要按下 

向后（REV）或向前（FWD）按钮进行手动调整。 
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  梯形图程序： 

   

  一旦有按钮按下，立即驱动输出，电动机运转一个扫描周期。这也意味 

着按钮时间长短与电动机驱动的时间没有关系。 

  

 练习：第一次按按钮指示灯亮，第二次按按钮指示灯闪亮，第三次按下按钮

指示灯灭，如此循环，试编写其 PLC 控制的 LAD 程序。 
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4.2.2 定时器指令 

  定时器可以提供等待时间或监控时间,定时器还可产生一定宽度的脉冲, 

亦可测量时间。定时器是一种由位和字组成的复合单元，定时器的触点 

由位表示，其定时时间值存储在字存储器中。 

 

         脉冲定时器（SP） 

         扩展脉冲定时器（SE） 

  定时器的种类     接通延时定时器（SD） 

         保持型接通延时定时器（SS） 

         关断延时定时器（SF） 

  1. 定时器组成 

   在 CPU 的存储器中留出了定时器区域，该区域用于存储定时器的定 

时时间值。每个定时器为 2Byte，称为定时字。在 S7－300 中，定时 

器区为 512Byte,因此最多允许使用 256 个定时器。S7 中定时时间由 

时基和定时值两部分组成，定时时间等于时基与定时值的乘积。当 

定时器运行时，定时值不断减 1，直至减到 0，减到 0 表示定时时间 

到。定时时间到后会引起定时器触点的动作。 

 

定时器的第 0到第 11 位存放二进制格式的定时值，第 12，13 位存

放二进制格式的时基。 

    

  时基与定时范围 
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时基 时基的二进制代码 分辨率 定时范围 

10ms 00 0.01s 10ms 至 9s_990ms 

100ms 01 0.1s 100ms 至 1m_39s_900ms 

1s 10 1s 1s 至 16m_39s 

10s 11 10s 10s 至 2h_46m_30s 

  

 为累加器 1装入定时时间值的表示方法： 

 （1）     L  W＃16＃wxyz 

  其中，w,x,y,z 均为十进制数； 

     w=时基，取值 0，1，2，3，分别表示时基为：10ms,100ms,1s,10s； 

   xyz=定时值，取值范围：1到 999。 

  （2）     L  S5T＃aH_bbM_ccS_dddMS 

 2.定时器启动与运行 

  PLC 中的定时器相当于时间继电器。在使用时间继电器时，要为其设置 

定时时间，当时间继电器的线圈通电后，时间继电器被启动。若定时时 

间到，继电器的触点动作。当时间继电器的线圈断电时，也将引起其触 

点的动作。该触点可以在控制线路中，控制其它继电器。 

 3.定时器启动指令 

LAD 指令 STL 指令 功能 

T no. 

---(SP) 

  时间值 

 

SP T no. 

 

 

启动脉冲定时器 

 

T no. 

---(SE) 

  时间值 

 

SE T no. 

 

 

启动扩展脉冲定时器 

 

T no. 

---(SD) 

  时间值 

 

SD T no. 

 

 

启动接通延时定时器 

 

T no. 

---(SS) 

  时间值 

 

SS T no. 

 

启动保持型接通延时定

时器 

 

T no. 

---(SF) 

SF T no. 启动关断延时定时器 
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  时间值 FR T no. 允许再启动定时器 

 

各种定时器的工作特点: 

 
4.定时器的梯形图方块指令 

 

参数 数据类型 存储区 说明 

N0. TIMER T 定时器标识号,与 CPU 有关 

S BOOL I,Q,M,D,L 启动输入 

TV S5TIME I,Q,M,D,L 设定定时间(S5TIME 格式) 

R BOOL I,Q,M,D,L 复位输入 

Q BOOL I,Q,M,D,L 定时器状态输出 

BI WORD I,Q,M,D,L 剩余时间输出(二进制格式) 

BCD WORD I,Q,M,D,L 剩余时间输出(BCD 码格式) 

5.定时器应用举例 

例一  脉冲发生器 

 用定时器可构成脉冲发生器,这里用了两个定时器产生频率占空比均可设置 

的脉冲信号。如下图的脉冲发生器的时序图，当输入 I0.0 为 1 时,输出 Q0.0 

为 1 或 0 交替进行，脉冲信号的周期为 3s，脉冲宽度为 1s。 
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 梯形图程序： 

  

 

 

例二  频率监测器 

 频率监测器用于监测脉冲信号的频率，若其低于下限，则指示灯亮，“确认” 

按键能使指示灯复位。为此，使用了一个扩展脉冲定时器，每当频率信号有 

一个上升沿就启动一次定时器。如果超过了定时时间没有启动定时器，则表 

明两个脉冲之间的时间间隔太长，即频率太低了。 

   

  梯形图程序: 
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例三  顺序循环执行程序 

当 X0 接通，灯 Y0 亮；经 5s 后，灯 Y0 灭，灯 Y1 亮；经 5s 后，灯 Y1 灭，

灯 Y2 亮，再过 5s 后，灯 Y2 灭，灯 Y0 亮，如此顺序循环，其时序图如下。 

                  

 梯形图程序： 
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例四  电动机顺序启动控制程序 

 有三台电动机 M1、M2、M3，按下启动按钮后 M1 启动，延时 5s 后 M2 启动， 

再延时 16s 后 M3 启动。 

 （一）PLC 接线 

   
 （二）定义符号地址 

    

 （三）梯形图程序 
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例五  分段传送带的电动机按制程序 

 

 为了节省能源的损耗，可使用 PLC 来启动和停止分段传送带的驱动电动机， 

使那些只载有物体的传送带运转，没有载物的传送带停止运行。金属板正在 

传送带上输送，其位置由相应的传感器检测。传感器安放在两段传送带相邻 

近的地方，一旦金属板进入传感器的检测范围，PLC 便发出相应的输出信号， 

使后一段传送带的电动机投入工作；当金属板被送出检测范围时，PLC 内部 

定时器立即开始计时，在达到预定的延时时间后，前一段传送带电动机便停 

止运行。 
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 （一）PLC 接线 

   
 （二）定义符号地址 

    

 （三）梯形图程序 
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 习题： 

 （1）有 4个答题人，出题人提出问题，答题人按动按钮开关抢答，只有最 

早按动按钮的人有输出。出题人按复位按钮，引出下一个问题，试编 

写 PLC 梯形图程序。 

    

 （2）若传送带上 30s 内无产品通过，检测器下的检测点则报警，试编写 

其梯形图程序。 
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（3）试编写 PLC 梯形图程序具备下述功能： 

  （a）按钮接通后 A灯先亮，过 5s 后 B 灯亮； 

  （b）B 灯亮 5s 后，自动关闭； 

  （c）B 灯灭 5s 后，A灯关闭。 

 （4）如下图（a）A，B，C三条传输皮带，分别受 M1，M2，M3 三个电动机拖 

动；图（b）是此三条传输皮带运转的时序图。编写一个用 PLC 控制它 

们运转的梯形图程序。要求它们按 A－B－C 顺序启动，而后按 C－B－ 

A 的顺序停止。 
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 （5）十字路口的交通指挥信号灯布置如下图： 
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 一、控制要求 

  （1）信号灯系统由一个启动开关控制，当启动开关接通时，该信号灯系 

统开始工作，当启动开关关断时，所有信号灯都熄灭。 

  （2）南北绿灯和东西绿灯不能同时亮。如果同时亮应关闭信号灯系统， 

并立刻报警。 

  （3）南北红灯亮维持 25s。在南北红灯亮的同时东西绿灯也亮，并维持 

20s。到 20s 时，东西绿灯闪亮，闪亮 3s 后熄灭，此时，东西黄 

灯亮，并维持 2s。到 2s 时，东西黄灯熄灭，东西红灯亮。同时， 

南北红灯熄灭，南北绿灯亮。 

  （4）东西红灯亮维持 30s。南北绿灯亮维持 25s，然后闪亮 3s 后熄灭。 

同时南北黄灯亮，维持 2s 后熄灭，这时南北红灯亮，东西绿灯亮。 

  （5）以上南北、东西信号灯周而复始地交替工作状态，指挥着十字路口 

的交通，其时序如下所示。 
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 二、PLC 接线 

   

 三、定义符号地址 
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 四、梯形图程序 
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 （6）PLC 控制的气缸延时控制回路，当气缸的活塞伸出到位停留 5s 后再返 

回，退回到位停留 3s 再伸出，如此往复运动。 

  （一）气控回路 

     
  （二）PLC 接线 
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（三）定义符号地址   

符号地址 绝对地址 类据类型 说明 

S0 I0.0 BOOL 启动按钮 

S1 I0.1 BOOL 停止按钮 

1S1 I0.2 BOOL 位置传感器 

1S2 I0.3 BOOL 位置传感器 

1Y1 Q0.0 BOOL 换向阀电磁线

圈 

1Y2 Q0.1 BOOL 换向阀电磁线

圈 

M0 M0.0 BOOL 启动线圈 

（四）梯形图程序       
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 （7）试编写以下机械手的 PLC 控制程序： 

   

            机械手 

  其动作的顺序如下，要求机械手在抓工件和松开工件时有 1s 的延时： 
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 （8）多种液体自动混合装置的 PLC 控制 

    如图所示为三种液体混合装置，SQ1、SQ2、SQ3 和 SQ4 为液面传感器， 

液面淹没时接通，液体 A、B、C 与混合液阀由电磁阀 YV1、YV2、YV3、 

YV4 控制，M为搅匀电动机，其控制要求如下： 

                  

    1.初始状态 

   装置投入运行时,液体 A、B、C 阀门关闭，混合液阀门打开 20s 将容 

器放空后关闭。 

     2.起动操作 

   按下启动按钮 SB1,装置开始按下列给定规律运转: 

   ①液体 A阀门打开，液体 A流入容器。当液面达到 SQ3 时，SQ3 按通， 

关闭液体 A阀门，打开液体 B阀门。 

   ②当液面达到 SQ2 时，关闭液体 B阀门，打开液体 C阀门。 

   ③当液面达到 SQ1 时，关闭液体 C阀门，搅匀电动机开始搅拌。 

   ④搅匀电动机工作 1min 后停止搅动，混合液体阀门打开，开始放出 
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混合液体。 

   ⑤当液面下降到 SQ4 时，SQ4 由接通变断开，再过 20s 后，容器放空， 

混合液阀门关闭，开始下一周期。 

  3.停止操作 

   按下停止按钮 SB2 后，要将当前的混合操作处理完毕后，才停止操 

作（停在初始状态） 

  参考程序： 
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（9）如下所示是三层楼电梯示意图。电梯的上升、下降由一台电动机控制；正 
转时电梯上升、反转时电梯下降。各层设一个呼叫开关（SB1、SB2、SB3）、 
一个呼叫指示灯（H1、H2、H3）、一个到位行程开关（ST1、ST2、ST3）。 

      

 控制要求： 
 （1）各层的呼叫开关为按钮式开关，SB1、SB2 及 SB3 均为瞬间接通有效 

（即瞬间接通的即放开仍有效）。   
 （2）电梯箱体上升途中只响应上升呼叫，下降途中只响应下降呼叫，任何 

反方向呼叫均无效，简称为不可逆响应。具体动作要求，如下表。 
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 （3）各楼层间有效运行时间应小于 10S，否则认为有故障、自动令电动机停 
转。 

输    入 输            出 
序号 原停

层 
呼叫层

运行方

向 
运  行  结  果 

1 1 3 升 
上升到 3 层停，这期间经过 2 层时

不停 
2 2 3 升 上升到 3 层停 
3 3 3 停 呼叫无效 
4 1 2 升 上升到 2 层停 
5 2 2 停 呼叫无效 
6 3 2 降 下降到 2 层停 
7 1 1 停 呼叫无效 
8 2 1 降 下降到 1 层停 

9 3 1 降 
下降到 1 层停，这期间经过 2 层时

不停 

10 1 2、3 升 
先升到 2 层暂停 2S 后，再升到 3
层停 

11 2 1、3 降 下降到 1 层停 
12 2 3、1 升 上升到 3 层停 

13 3 2、1 降 
先降到 2 层暂停 2S 后，再降到 1
层停 

14 任意 任意 任意 
楼层间运行时间必须小于 10S，否

则停 
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（10）霓虹灯广告屏控制器的设计 
     用 PLC 对霓虹灯广告屏实现控制，其具体要求如下： 

            
   该广告屏中间 8 个灯管亮灭的时序为第 1 根亮→第 2 根亮→第 3 根 

亮→…→第 8 根亮，时间间隔为 1s，全亮后，显示 10s，再反过来从 
8→7→…→1 顺序熄灭。全灭后，停亮 2s，再从第 8 根灯管开始亮 
起，顺序点亮 7→6→…→1，时间间隔为 1s，显示 20s，再从→2→…→8 
顺序熄灭。全熄灭后，停亮 2s，再从头开始运行，周而复始。 

 参巧梯形图程序： 
 
 
 
 
 
 
 
 
 

 ７２

www.gongkong365.com
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